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Inleiding

Dit document beschrijft hoe u een softwareafbeelding kunt upgraden op Cisco ASA 5500-
applicaties met Cisco Adaptive Security Device Manager.

Voorwaarden

Vereisten

Er zijn geen specifieke vereisten van toepassing op dit document.

Gebruikte componenten

De informatie in dit document is gebaseerd op de volgende software- en hardware-versies:

Cisco ASA 5500 en ASA 5500-X 9.1(2) en hoger•

Cisco ASDM 7.1 en hoger•

De informatie in dit document is gebaseerd op de apparaten in een specifieke 



laboratoriumomgeving. Alle apparaten die in dit document worden beschreven, hadden een 
opgeschoonde (standaard)configuratie. Als uw netwerk live is, moet u zorgen dat u de potentiële 
impact van elke opdracht begrijpt.

Verwante producten

Deze configuratie kan ook worden gebruikt met Cisco ASA 5500-X Series security applicatie 
versie 9.x.

Conventies

Raadpleeg Cisco Technical Tips Conventions (Conventies voor technische tips van Cisco) voor 
meer informatie over documentconventies.

Software downloaden

Gebruik deze koppelingen om de vereiste release-versie van ASA Software-afbeeldingen en 
ASDM Software-afbeeldingen te downloaden:

Cisco ASA Software release downloaden (alleen geregistreerde klanten)•

Cisco ASDM-softwarerelease Download (alleen geregistreerde klanten)•

Opmerking: er zijn geldige Cisco-gebruikersreferenties nodig om deze software te 
downloaden van Cisco.com.

Compatibiliteit tussen ASA en ASDM

De getoonde link wordt bijgewerkt met de compatibiliteit en de door Cisco aanbevolen ASDM-
release voor elke versie van ASA.

ASA- en ASDM-compatibiliteit

ASA upgrade-pad

De getoonde link biedt het upgradepad voor ASA. Sommige versies vereisen een tussentijdse 
upgrade voordat u kunt upgraden naar de nieuwste versie.

ASA upgrade-pad

Upgrade een ASA-softwareafbeelding met het gebruik van ASDM 
7.x

Voltooi de volgende stappen om een softwareafbeelding op de ASA 5500 te upgraden met behulp 

https://www.cisco.com/c/nl_nl/support/docs/dial-access/asynchronous-connections/17016-techtip-conventions.html
https://software.cisco.com/download/home/278875415
https://software.cisco.com/download/home/279513399/type/280775064/release/7.17.1.155
/content/en/us/td/docs/security/asa/compatibility/asamatrx.html#pgfId-121785
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/planning.html#id_58680


van ASDM.

1. Wanneer ASA in de Single context Mode is, selecteert u Tools > Upgrade Software from Local Computer... 
vanuit het Home-venster van de ASDM.

 

Wanneer ASA in Meervoudige contextmodus wordt uitgevoerd, wordt de Upgrade Software from Local 

Computer optie onder de Tools Het menu tabblad is alleen beschikbaar vanuit Systeemcontext.

 
2. Selecteer ASA als het te uploaden afbeeldingstype in de vervolgkeuzelijst.

 



 
3. Klik op Browse Local Files... of typ het pad in de Local File Path veld om de locatie van de 
softwareafbeelding op de pc te specificeren. 
 
4. Klik op Bladeren.... 
 
5. Er wordt een dialoogvenster Bladeren van Flash weergegeven, waarbij de bestandsnaam 
automatisch wordt ingevoerd. Als de bestandsnaam niet wordt weergegeven, voert u deze 
handmatig in op File Name veld. Klik op de knop OK als het klaar is. 
 

 
 
6. Zodra zowel de lokale als de externe bestandsnamen zijn opgegeven, klikt u op Upload Image.

 



 
 
7. Een statusvenster wordt weergegeven terwijl ASDM de afbeelding naar flitser schrijft. Als u 
klaar bent, verschijnt een informatievenster dat aangeeft dat het uploaden is geslaagd en wordt u 
gevraagd of het beeld moet worden ingesteld als het opstartbeeld. Kiezen Yes.



Klik op de knop OK in het dialoogvenster Informatie en klik vervolgens op Close in het 
dialoogvenster Afbeelding uploaden vanaf lokale pc. 

8. Kies Tools > System Reload van het Home-venster om het apparaat opnieuw te laden.

 
 

Er verschijnt een nieuw venster dat de details van de herlading verifieert. Kiezen Save the running 

configuration at the time of reload en kies vervolgens een tijdstip voor herladen. De keuze van de tijd is 
onder meer:

Herstart het apparaat onmiddellijk.•
Vertraging door — Geef aan hoeveel minuten of uren u van nu wilt wachten om het apparaat 
opnieuw te laden.

•

Schema op — Geef een tijdstip en datum op waarop het apparaat moet worden herladen.•

 
Specificeer bovendien of het apparaat een herlading onmiddellijk moet forceren als een geplande 
herlading mislukt. controleren On Reload failure, force an immediate reload after en specificeer vervolgens een 
maximale wachttijd. Dit is de tijd gedurende welke het beveiligingstoestel wacht om andere 
subsystemen te informeren voordat het wordt uitgeschakeld of opnieuw wordt opgestart. Na deze 
tijd wordt de machine snel (gedwongen) uitgeschakeld/opnieuw opgestart. Klik op de knop Schedule 

Reload.

 



 
Wanneer het herladen is gestart, wordt een Reload Status venster-displays om aan te geven dat een 
herlading bezig is. Er is ook een optie om ASDM te verlaten. 
 

Opmerking: start ASDM opnieuw nadat de ASA opnieuw is geladen.

 



Upgrade het ASDM-image met behulp van ASDM 7.x.

Voltooi de volgende stappen om een softwareafbeelding op de ASA 5500 te upgraden met de 
ASDM-image.

1. Selecteer Tools > Upgrade Software from Local Computer... van de Home venster van de ASDM.

 



 
 
2. Selecteer ASDM als het type afbeelding dat u wilt uploaden uit de vervolgkeuzelijst.

 
3. Klik op Browse Local Files...  of typ het pad in de Local File Path veld om de locatie van de 
softwareafbeelding op de pc te specificeren.

Klik op de knop Browse Flash....

A Browse Flash verschijnt een dialoogvenster met de bestandsnaam die automatisch wordt 
ingevoerd. Als de bestandsnaam niet wordt weergegeven, voert u deze handmatig in op File Name 
veld. Klik op de knop  OK wanneer geëindigd.



 
4. Klik op OK wanneer de afbeelding wordt bijgewerkt met de nieuwe afbeelding.

 
5. Selecteer File > Save Running Configuration to Flash van de Home venster van de ASDM.

 



 
Sluit de ASDM en log opnieuw in om de ASA te beheren met het opgewaardeerde ASDM-beeld.

Upgrade de ASA en ASDM met een image Downloaden Direct 
vanaf CCO

 
Voltooi deze stappen om een ASA- en ASDM-image rechtstreeks te upgraden vanuit CCO. 
 
1. Selecteer Tools > Check for ASA/ASDM Updates... van de Home venster van de ASDM.

 
2. Wanneer de gebruikersnaam en de wachtwoordprompt worden weergegeven, specificeert u de 
Cisco.com referenties en klikt u op Login.



 
 
3. De Cisco.com Upgrade Wizard dialoogvenster wordt weergegeven. In het Overview sectie klikt u op Next. 
 



 
 
4. In de Select Software controleren of de software die geüpgraded moet worden, werkt. Als zowel 
ASA als ASDM moet worden bijgewerkt, controleer dan beide opties. 
 



 
5. Selecteer in de vervolgkeuzelijst ASA-versie de versie waarvoor de ASA-upgrade moet worden 
uitgevoerd.



 
6. Selecteer in de vervolgkeuzelijst ASDM-versie de versie waaraan de ASDM-upgrade moet 
worden uitgevoerd. Klik op de knop Next wanneer de passende versies zijn geselecteerd.



 
7. In de Review Changes sectie, bekijk de wijzigingen en klik op Next.



 
8. De installatie van de beelden begint en de algemene vooruitgang kan als getoond worden 
gezien. Klik na het voltooien op Finish. 
In het Results sectie, controleer de Save configuration and reload device now optie. Klik op de knop Finish.



 
9. De Reload Status het dialoogvenster wordt weergegeven terwijl het apparaat wordt herladen.



 
10. Klik op Exit ASDM en log opnieuw in zodra het apparaat omhoog komt na herladen.

CLI gebruiken om een softwareafbeelding en een ASDM-
afbeelding te upgraden

Een TFTP-server is vereist om een softwareafbeelding te upgraden of te downgraden, evenals 
een ASDM-afbeelding voor een ASA. Raadpleeg TFTP-serverselectie en -gebruik voor meer 
informatie over de selectie van TFTP-servers.

Het copy tftp flash Met deze opdracht kan een softwareafbeelding worden gedownload naar het 
Flash-geheugen van de firewall via TFTP. Gebruik de copy tftp flash commando met elk model van 
security applicatie. Het gedownloade beeld kan nu bij de volgende reboot door een verandering 
van de variabele van het laarssysteem worden gebruikt om aan dit beeld te richten.

Dit is de uitvoer van de copy tftp flash opdracht:

 

copy tftp[:[[//location] [/tftp_pathname]]] [[flash/disk0][:[image | asdm]]]

https://www.cisco.com/c/nl_nl/support/docs/routers/10000-series-routers/48700-tftp-server.html


 

Voor de meervoudige contextmodus, voert u deze stappen uit in de ruimte voor 
systeemuitvoering.

Opmerking: voor ASA vervangt keyword disk0 flash in de copy uit.

Als de opdracht wordt gebruikt zonder de optionele parameter location of pathname, worden de 
locatie en bestandsnaam op interactieve wijze verkregen van de gebruiker door een reeks vragen 
die vergelijkbaar zijn met de vragen die worden gepresenteerd door Cisco IOS® software. Als er 
alleen een dubbele punt wordt ingevoerd, worden de parameters afgeleid van de tftp-server 
opdrachtinstellingen. Als andere optionele parameters worden meegeleverd, dan worden deze 
waarden gebruikt in plaats van de bijbehorende tftp-server opdrachtinstelling. Als om het even welke 
facultatieve parameters, zoals een dubbelpunt en om het even wat nadat het wordt geleverd, loopt 
het bevel zonder een herinnering voor gebruikersinput.

De locatie is een IP-adres of een naam die zich in een IP-adres bevindt door het 
naamoplossingsmechanisme van het security apparaat, dat momenteel statisch wordt 
toegewezen door de name en names opdrachten. Het security apparaat moet weten hoe deze locatie 
te bereiken door zijn routeringstabel informatie. Deze informatie wordt bepaald door de IP address,het 
route, of de RIP opdrachten. Dit hangt af van uw configuratie.

De pathname kan om het even welke foldernamen naast de daadwerkelijke laatste component 
van de weg aan het dossier op de server omvatten. De padnaam mag geen spaties bevatten. Als 
een directorynaam spaties heeft, stelt u deze in op de directory in de TFTP-server in plaats van in 
de copy tftp flash uit. En als uw TFTP-server is geconfigureerd om te wijzen naar een map op het 
systeem waarvan u de afbeelding downloadt, gebruikt u alleen het IP-adres van het systeem en 
de bestandsnaam van de afbeelding. De TFTP-server ontvangt de opdracht en bepaalt de 
feitelijke bestandslocatie aan de hand van de informatie in de hoofdmap. De server downloadt 
vervolgens het TFTP-beeld naar het security apparaat.

Deze opdrachten zijn nodig om de software-image te upgraden, evenals het ASDM-image, en om 
het bij het volgende opnieuw laden als een opstartbeeld te maken.

 
<#root>

ASA

#copy tftp [[flash:/disk0:][software image name/asdm image name]]

 

!--- Command to set an image as bootup or specify the 

!--- ASDM image file.

 
 
ASA(config)

#boot system [flash:/disk0:]/[software image name]

 



!--- Save active configuration to the Flash.

 
ASA

#write memory

 

!--- Reboot the security appliance and load 

!--- with the new boot image as per the configuration file.

 
ASA

#reload 

 

Voorbeeld:

 
<#root>

ASA-5512# copy tftp: disk0: 
 
Address or name of remote host []? 172.16.31.1 
Source filename []? asa916-smp-k8.bin 
Destination filename [asa916-smp-k8.bin]? 
Accessing tftp://172.16.31.1/asa916-smp-k8.bin...!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
Writing file disk0:/asa916-smp-k8.bin... 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! 
38043648 bytes copied in 32.290 secs (1188864 bytes/sec) 
 
ASA-5512# sh disk0 
--#--  --length--  -----date/time------  path 
 

 191  38191104    Nov 21 2014 21:07:48  asa912-smp-k8.bin 

  192  17906032    Apr 08 2015 22:33:44  asdm-713.bin 

  193  26350916    Apr 09 2015 06:28:20  asdm-741.bin 

  194  38043648    May 10 2015 02:14:06  asa916-smp-k8.bin 

 

4118732800 bytes total (3556712448 bytes free) 
 
 

!--- Command to set "asa916-smp-k8.bin" as the boot image.

 
ASA-5512(config)

# boot system disk0:/asa916-smp-k8.bin

 

!--- Command to set "asdm-741.bin" as the ASDM image.

 
ASA-5512(config)



# asdm image disk0:/asdm-741.bin

ASA-5512

# write memory

ASA-5512

# reload 

 

Opmerking: wanneer u probeert de afbeelding in de ASA te upgraden vanaf een FTP-server, 
gebruikt u de copy ftp flash uit. Met deze opdracht kunnen parameters, zoals het externe IP-
adres en de naam van het bronbestand worden gespecificeerd. Deze procedure is 
vergelijkbaar met TFTP. Een beperking is echter dat u de externe IP/bron-interface niet kunt 
wijzigen (zoals u kunt met TFTP). In de TFTP-modus worden opties gespecificeerd met 
de tftp-server kan worden getrokken en uitgevoerd. Maar FTP bestaat niet. Standaard is de 
broninterface altijd de buitenkant, die niet kan worden aangepast. Dat wil zeggen dat de FTP 
server bereikbaar is via de buiteninterface.

Verifiëren

Gebruik dit gedeelte om te bevestigen dat de software-upgrade is geslaagd.

De Cisco CLI Analyzer (alleen geregistreerde klanten) ondersteunt bepaalde show opdrachten. 
Gebruik de Cisco CLI Analyzer om een analyse van de show opdrachtoutput.

Nadat de ASA opnieuw is geladen en met succes opnieuw is aangemeld bij ASDM, controleert u 
de versie van de afbeelding die op het apparaat wordt uitgevoerd. Bekijk de General tab op het Home 
venster voor deze informatie.

Deze CLI-opdrachten worden gebruikt om de upgrade te verifiëren:

Versie weergeven — Dit is de huidige afbeelding waarmee de ASA is opgestart.1. 

https://cway.cisco.com/cli
http://tools.cisco.com/RPF/register/register.do


Bootvar tonen — Dit toont de prioriteit van de afbeelding die gebruikt moet worden na het 
opnieuw laden.

2. 

Afbeelding weergeven — Dit toont de huidige ASDM-afbeelding die door de ASA wordt 
gebruikt.

3. 

Problemen oplossen

Er is momenteel geen specifieke informatie beschikbaar om deze configuratie problemen op te 
lossen.

Gerelateerde informatie

Release-opmerkingen•
Cisco ASA nieuwe functies per release•
Cisco ASA-compatibiliteit•
Uw upgrade plannen•
Configuratie van een upgrade van een Active/Standby failover•

https://www.cisco.com/c/nl_nl/support/security/asa-5500-series-next-generation-firewalls/products-release-notes-list.html
/content/en/us/td/docs/security/asa/roadmap/asa_new_features.html
/content/en/us/td/docs/security/asa/compatibility/asamatrx.html
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/planning.html
/content/en/us/td/docs/security/asa/upgrade/asa-upgrade/asa-appliance-asav.html#concept_xxv_yvn_kkb


Over deze vertaling
Cisco heeft dit document vertaald via een combinatie van machine- en menselijke
technologie om onze gebruikers wereldwijd ondersteuningscontent te bieden in hun eigen
taal. Houd er rekening mee dat zelfs de beste machinevertaling niet net zo nauwkeurig is als
die van een professionele vertaler. Cisco Systems, Inc. is niet aansprakelijk voor de
nauwkeurigheid van deze vertalingen en raadt aan altijd het oorspronkelijke Engelstalige
document (link) te raadplegen.


